
LUCIS Software Version 3.2
Release Notices

Release 3.2.0 Notice - 9/06/2006

Release 0 updates the runtime (the LUCIS programs are the same as version 3.1.8 build 
4).  Version 3.2 must be installed to upgrade from previous versions.  Because the runtime is 
being updated, the installation instructions are different than normal.  Retrieve the installation 
instructions for the Version 3.2 Installer from the LUCIS Download or Resources web pages.

Release 3.2.1 Notice - 1/10/2007

Highlights (since release 3.2.0)
Initial release of production donation module programs (alpha pre-release was in 
October)
Added contributions to Church Accountant export
Refined School Accountant export/import process
New standard G/L budget worksheet reports
Completed helps (AD/GL/DN,etc)

Detail (since release 3.2.0)
CAExport - allow either accounting or contribution export or both
SAExport - modified error messages and notes to user; export A/R detail within each month
LUCIS - activated donations module menu items
ADBackup - provide zip option, set default path for backup; create backup folder if needed
ADCEdit - edited repot title
ADList - fixed printing of 4-line addresses
ADImport - prevent School Accountant address import if address book already contains data
ADLookup - changed to allow space, or not, following comma in last/first name search;  

changed error message when address file cannot be found when querying from 
G/L

GLTLookup - allow date search to start on partial date entry
GLAEdit - added global budget option for Standard+ Edition
GLTReceipt - realigned return address for double-window envelopes
GLLedger - changed Std+ options same as Std
GLTBatch - fixed out-of-balance error when using line 499 in entry screen, fixed error 

message when retrieving saved batch of 499 lines
GLTImport - changed to automate posting to G/L from donation module
GLClose - use source path if no path is specified for destination
GLAStmt - realigned return address for double-window envelopes
GL1099I - edited for 2006 change in magnetic media, implemented 2006 print format 

change
GLTInterest - use post thru date rather than system date for entries
GLFReports - expanded to allow longer line references and descriptions for financial reports
GLExport - fixed end-of-account# selection (account export did not stop at THRU account)
GLFileIn - accommodate import of monthly A/R detail from School Accountant (previously 

imported A/R detail was all shown at year-end)
RptStyleEditor - edited error message for print detail indicators



DN Programs - initial production release of donation module programs



Release 2 Notice - 3/06/2007

Highlights (since release 3.2.1)
edited numerous screen displays and keyboard navigation for consistent look-and-feel
added "Add" and "Edit" functionality to donor, offering, address, and ledger account 
queries
ability to assign temporary OrgMastID for churches not yet in Archives & Statistics list
fixed numerous minor bugs and added ease-of-use enhancements and messages

Detail (since release 3.2.1)
LUCIS Installer - fixed incorrect working folder on shortcut for new network client installs; 

set all program files (.exe and .dll) to read-only to avoid "Invalid Win32 
application error" on some unique server-client configurations and speed up 
program loading

CAExport - added "Include inactive donor?" to allow import of ALL donors rather than just 
currently active donors; added additional checks for offering export

LUCIS-X - rebuilt to avoid occasional "Library Work Area is Broken" error message.
LUCIS.ENT - updated entity lookup table to latest Archives & Statistics list
Helps - updated several helps, including CA-to-LUCIS and SA-to-LUCIS

ADAEdit - remove "Add?" prompt when using "#" to add address

GLPayments - display payee name same as in address lookup (reformatted for printing)
GLReceipt - adjusted return address alignment; display receipt from name same as in address 

lookup (reformatted for printing)
GLTEntry - warn if date is out-of-range of ledger fiscal year before allowing entry
GLTBatch - adjusted CR (receipt) return address alignment; warn if date out-of-range of 

ledger fiscal year before allowing entry
GLAStmt - edited screen display and keyboard navigation
GLAList - edited screen display and keyboard navigation; added print options for additional 

information dependent on software edition and ledger level; added "*" to account 
number if non-posting; added message on list if aging balance not equal to 
ending balance

GLTList - edited screen display and keyboard navigation
GLABalance - edited screen display and keyboard navigation
GL1099I - edited screen display and keyboard navigation; added "AddrBk" to address source 

selection
GLFReport - prevent "No Report Controls" error message when switching control file with no 

data file(s) open
GLClose - fixed display of options in detail section of window
GLOrganizer - redisplay updated accounts for level II, III, IV ledgers when function name 

changes; require full/abbv names for functions and classes before "Save"
GLTSplit - new program to split multi-function ledgers (e.g. trust, endowment, agency, etc.)

DNDQuery - fixed problem not being able to select a donor with ID containing a significant 
digit in second decimal position; added "Entries" button for donation entry 
lookup; enabled "Add" button for file with no donors

DNOQuery - enabled "Add" button for file with no offering codes
DNTQuery - added "Select" button as alternative to double-click
DNTEntry - changed receipt amount table to prevent horizontal scroll when resizing 



window; minor editing of window text; default to donor name sequence for 
donor query; donor name is displayed same as in DNDQuery; use last donor 
when "=" is entered at donor ID or name; additional date checking to avoid 
entering donations to wrong year

DNTImport - modified fixed-field import format to allow 11-char reference and 15-char 
amounts

DNTClose - changed default batch close date to last date used for entries in batch; warnings 
for unusual situations

DNClose - prevent overlapping batch between closed months
DNT2GL - allow batches netting zero (i.e. corrections) to be posted to GL (zero posting will 

record batch number to avoid number gaps); changed default posting date to date 
used when batch was closed (i.e. deposit date); create print JV and/or voucher file 
for non-LUCIS ledgers

DNDLists - fixed typo in information message to user; edited report layout to allow long 
donor IDs and longer donor names; edited report footnote (donors: joint and non-
posting; offerings: non-posting and non-deductible)

DNOLists - edited report layout to allow for longer offering names; added footnote for non-
posting and non-deductible

DNTLists - edited report layout to allow for longer offering names; entering "=" in "Thru 
Batch" will now repeat the batch number in "From Batch", edited report footnote 
(donors: joint and non-posting; offerings: non-posting and non-deductible); 
warnings for unusual situations

DNORemit - allow for longer offering names; added list of deposits at end of report; fixed 
occasional dropping of an offering line (subtotals and totals were not affected); 
warnings for unusual situations; default batch range from last month closed; 

DNDStmt - warnings for unusual situations
DNTDeposit - edited for screen navigation and to print zero amount line for entry sets 

without receipt amounts (e.g. corrections of offering distribution only)
DNCList - modified options for Lite/Standard Editions.
DNDEdit - fixed "Illegal Function Call" when using "#" to add next donor ID; new ID is 

assigned at time save to prevent problems with multiple users adding IDs; added 
prompt to update address of all family members (same integer ID, different 
decimals) when changing address; default to existing family address when adding 
new family member ID; fixed error when "Cancel" is selected;  fixed program 
abort when DNDEdit is called from DNDQuery; skip "Save" prompt when 
cancelling or exiting and no data was edited.

DNOEdit - allow add/edit from DNOQuery; fixed "G/L control missing" warning message
DNVerify - implemented additional data checks
DNExport - modified LUCIS Import Entry format to match DNTImport changes noted 

above 
DNCEdit - allow "temporary" OrgMastID to identify company/church not yet assigned an 

OrgMastID by Archives and Statistics (use conference ID and change last two 
digits to 00); automatically update parent organization address when parent 
changes (based on OrgMastID); edited screen display; 

DNImport - fixed import from CA for last batch posted and last closed batch



Release 3 Notice - 5/31/2007

Highlights (since release 3.2.2)
Updated numerous screens to standardize look-and-feel; in deference to Microsoft we 
now require use of the Ctrl key for keyboard control of on-screen movement (Ctrl-
Up/DownArrow, Ctrl-Right/LeftArrow; etc.); Shift-Enter now goes the opposite direction 
from Enter (similar to Shift-Tab vs. Tab);  NOTE: standardizing look-and-feel is an 
ongoing work-in-progress that should be completed by the next update release
Added user prompts and links between programs to guide users
Fixed numerous small "bugs"
Added "Delete Fileset" and "Backup Folder" options to the main File menu
Updated CAExport to accommodate unusual conditions we have encountered
Added "GL Account Query" to the main General Ledger menu
Lite and Standard ledgers now use the standard GL Account Query for account lookup 
(were previously using GLOrganizer for account lookup)
Implemented the new Canadian cheque Standard 006 as an option in GL
Added features in Donations Entry to speed entry process

Detail (since release 3.2.2)
numerous screens - updated to standardize look-and-feel
LUCIS.exe (LUCIS Manager) - modified Windows registry update to accommodate 

Windows Vista; added "Delete Fileset" and "Backup Folder" options to File menu; 
added "Image Viewer", "Custom Reports", and "Adventist Entity Query" to Tools 
menu; added "GL Account Query" to General Ledger menu

LUCIS.ent (LUCIS Entity Query database) - updated from current GC database
CAExport.exe - now exports offering codes less than 80 if used (not a normal condition) and 

flagged as non-posting; modified to accommodate old versions of Church 
Accountant; limit transaction numeric reference to 5 digits; now exports 85-
Conference Remittance as non-posting if an "offering" was posted to it

Address Module:
ADCreate (AD Create New Address Book) - save newly created filename in recent file list; 

default to LUCIS\DATA folder for new address book
ADDelete (AD Delete Address Book) - delete an address book (only in main File menu)

General Ledger Module:
All GL Programs where account lookup is applicable - changed to use standard GL Account 

Query for Lite/Std ledgers (were using GLOrganizer previously for account 
lookup)

GLCEdit (GL Controls Editor) - remove path from parent/child filename
GLAEdit (GL Account Editor) - added checkbox for new Canadian check format standard; 

fixed "Invalid Function Call" error in unusual situations; Enter key can now be 
used to terminate an ID entry as well as "OK" button

GLPayments (GL Payment Entry) - implemented Canadian Cheque Standard 006
GLReceipts (GL Receipt Entry) - fixed "Source Account" & "Received From" Alt-key 

shortcuts
GLTEntry (GL General Entry) - fixed "Date", "Journal ID" & Voucher#" Alt-key shortcuts
GLTBatch (GL Batch Entry) - implemented Canadian Cheque Standard 006
GLTInterest (GL Interest Processing) - implemented Canadian Cheque Standard 006
GLClose (GL Monthly/Annual Closing) - removed Overwrite/Update option when 



performing annual reclose (delete option in main File menu can be used to delete 
a ledger fileset if the intention is to replace i.e., overwrite); allow backup to be 
performed while file is still open in GLClose

GLTReconcile (GL Account Reconciliation) - fixed "Index Invalid" message in several 
unusual conditions; filenames are printed in body of outstanding items list only if 
there are outstanding items in prior year

GLAStmt (GL Account Statement) - edited screen display
GLAgeRpt (GL Aging Reports) - fixed "Index Invalid" error when double-selecting a class
GL1099I (GL 1099-INT Report) - fixed "Index Invalid" error when double-selecting a class
GLTInterest (GL Interest Processing) - fixed "Index Invalid" error when double-selecting a 

class
GLCreate (GL Create New Ledger Fileset) - save new filename in recent file list
GLDelete (GL Delete General Ledger Fileset) - delete a ledger (only in main File menu)
GLVerify - fixed abnormal response when release class is not identified in the controls

Donations Module:
DNDLookup (DN Donor Query) - fixed "Remove Filename" option of File menu (did not 

update the file list to show that the name was removed)
DNOLookup (DN Offering Query) - fixed "Remove Filename" option of File menu (did not 

update the file list to show that the name was removed)
DNCEdit (DN Controls Editor) - remove path from parent/child filename; fixed to retain GL 

Voucher selection for Other than LUCIS ledger type; prevent saving invalid 
OrgID; edited and added user messages

DNDEdit (DN Donor Editor) - fixed error message when canceling ADD of new donor; 
fixed mis-assignment of ID when changing ID to "#" during donor edit

DNOEdit (DN Offering Editor) - fixed open state of offering lookup to be in ID or name 
sequence depending on the text entered before calling the lookup; fixed "Remove 
Filename" in File menu (did not remove name previously)

DNTEntry (DN Open Batch Entry/Edit) - prompt for monthly or annual closing if using date 
is for the next period; edited menu wording; default for shortcut from name area 
to receipt amount (Ctrl-PgDown) is now the first check entry area rather than 
cash (to get to cash press Ctrl-UpArrow from check entry); added "Change Open 
Batch Date" to Entries menu; allow ID in name area (or ID area) to identify a 
donor; automatically launch Donor Query if ID is not provided or cannot be 
found

DNTClose (DN Close Open Batch) - added "Preview Entries" and "Preview Deposit" buttons; 
additional date checking; automatically prompt to re-close month 12 when 
adding a batch after month 12 has previously been closed and to re-close year if 
it has already been closed; added "Change Closed Batch Date" to Utilities menu; 
modified to track additional batches in prior year (e.g., adjusting entries)

DNClose (DN Monthly/Annual Close) - edited messages; automatic Remittance Statement 
when re-closing month 12 for adjusting entries after annual closing has been 
performed; removed Overwrite/Update option when performing annual reclose 
(delete option in main File menu can be used to delete a donations fileset if the 
intention is to replace i.e., overwrite); allow backup to be performed while file is 
still open in DNClose; modified to track additional postings in prior year (e.g., 
adjusting entries); initialize  new filename for annual close if year is in filename

DN2GL (DN Post Closed Batch to GL) - fixed post date out-of-range checking; fixed post 
date initialization when batch does not exist; modified to track additional prior 
year unposted batches (e.g. adjusting entries); JV file is now placed in the data 



folder rather than the LUCIS base folder; added voucher report for ledger that 
cannot be located and non-LUCIS ledgers; edited messages to user; increased 
length allowed for account name in voucher

DNTLists (DN Entry Lists) - added warning if batch range is not for full months; edited other 
warning messages; start entry lookup at batch entered if any; fixed use of "~" to 
represent highest selection for "Thru" batch, donor, and/or offering

DNORemit (DN Remittance Report) - fixed problem with repeating last remittance line when 
there are no local offerings; added warning if batch range is not for a full month; 
edited messages

DNDStmt (DN Donor Statement) - added warning if batch range is not for full month; fixed 
use of "~" to represent highest selection for "Thru" batch and/or donor

DNVerify (DN Verify Donation Data) - completed checks for entries, offerings and donors; 
fixed error in file recover logic that reset file to 0 bytes

DNExport (DN Export Donation Data) - default entry data batch lookup to "All" Batches
DNCreate (DN Create New Donations Fileset) - save newly created filename in recent file list
DNDelete (DN Delete Donations Fileset)- delete a donations fileset (only in main File menu)

Release 4 Notice - 8/13/2007

Highlights (since release 3.2.3)
Continued work on standardized look-and-feel.
Added a Print Screen menu item to GL windows (others will be updated shortly).  In 
applicable cases a Print List/Report option has also been added.
Added more user prompts and links between programs to guide users (a continuing 
effort)
Fixed numerous small "bugs"
Added "Rename Fileset" options to the main File menu
Added financial reporting options to DN Entry Lists (via custom report templates)
Updated numerous help chapters; added chapters for original setup for churches/schools; 
updated Transfer from The Church/School Accountant chapters, added orientation 
chapters for Church/School Accountant Users (also available on the Resources page of 
our web site), added a guide to LUCIS Use for Schools (churches to follow).

Detail (since release 3.2.3)
numerous screens - continued work on standardized look-and-feel
LUCIS.exe (LUCIS Manager) - added "Rename Fileset" to File menu; removed DN Financial 

Reports from Donations menu (use DN Entry Lists instead)
LUCIS.ent (LUCIS Entity Query database) - updated from current GC database
RptEdit-C (LUCIS Report Controls Editor) - added donation financial report controls (used 

by DN Entry Lists)

Address Module:
ADCreate (AD Create New Address Book) - no longer advances to AD Controls Editor at 

end; initialize new address book with LUCIS address to avoid AD Query error 
accessing an empty file

ADRename (Rename Address Book) - rename an address book (only in main File menu)
ADVerify (AD Verify Address Book) - fixed file status recover logic

General Ledger Module:



GL Programs - added a Print Screen menu option; also Print List/Report where applicable
GLRename (Rename General Ledger Fileset) - rename a ledger fileset (only in main File 

menu)
GLCEdit (GL Ledger Controls Editor) - changed "Parent" to "Last Year" in associated ledger 

controls; added "Next Year" to associated ledger controls (normally set during 
annual close)

GLAEdit (GL Account Editor) - pressing [Enter] at account ID without entering ID will 
retrieve last ID edited; set update access for mid-level items; fixed disabled 
budget distribution needed for correcting imported distribution rounding 
problems

GLPayments (GL Payments Entry) - added extra memo feature for ledger level III (Std)
GLReceipts (GL Receipts Entry) - added extra memo feature for ledger level III (Std)
GLTEntry (GL General Entry) - fixed "Print Voucher" menu item not working on first click; 

added extra memo feature for ledger level III (Std)
GLTImport (GL Import Entries) - removed warning for future date as long as date is within 

fiscal year; prevent posting to balance accounts
GLTEdit (GL Entries Editor) - fixed journal selection for journal type change
GLClose (GL Monthly/Annual Close) - prompt operator to run GL Verify if an abnormal file 

status is reported by the operating system; added additional prompts to guide 
operator; automatically set balance accounts to non-posting after 1st year (no 
longer set after 1st monthly close)

GLTInterest (GL Interest Processing) - fixed misalignment after initial form when printing 
interest checks

GLTLookup (GL Ledger Query) - fixed window closing when [Enter] is pressed after query 
is called from main menu

GLTLists (GL Entry Lists) - fixed wrong journal list when operator selects CR-Cash Receipts 
for ledger levels II (Lite), III (Std), and IV (Std+)

Donations Module:
DNRename (Rename Donations Fileset) - rename a donations fileset (only in main File menu)
DNOEdit (DN Offering Editor) - prevent assignment to general ledger non-posting or 

balance accounts
DNImport (DN Donation Fileset Import) - recognize closed batches from imported data
DNCEdit (DN Controls Editor) - added option for Treasurer's name; set update access for 

mid-level items; changed "Parent" to :"Last Year" and "Child" to "Next Year" in 
associated donation fileset controls

DNTEntry (DN Open Batch Entry/Edit) - donor name/address must be edited using DN 
Donor Editor

DNClose (DN Monthly/Annual Close) - prompt operator to run DN Verify if an abnormal 
file status is reported by the operating system; added prompt to guide user

DN2GL (DN Post Closed Batch to GL) - added messages to guide operator when 
transitioning between ledger fiscal years, changed access level from 7 to 5

DNDLookup (DN Donor Query) - changed access level from 1 to 3
DNTLists (DN Entry Lists) - added financial reporting options (via custom report templates), 

automatically update report template file with new DN templates (this time only); 
changed access level from 2 to 3

DNORemit (DN Remittance Report) - added footnote page for offering, remittance, 
destination, and purpose codes; added option to include treasurer's name on 
report

DNDStmt (DN Donor Statements) - added option to include treasurer's name on statements



DNVerify (DN Verify Donations Data) - added check for unposted batches in prior year; 
added check for valid "Last Year" and "Next Year" associated filesets



 Release 5 Notice - 11/08/2007

Highlights (since release 3.2.4)
Continued work on standardized look-and-feel.
Added a Print Screen menu item to AD and DN windows.  In applicable cases a Print 
List/Report option has also been added.
Improved LUCIS Installer (used for updates as well) to automate more functions and 
adapt to Windows Vista requirements
Added total/grandtotal (offering/donor/batch) counts to DN Entry Lists.
Updated numerous help chapters; added chapter for LUCIS Use for Churches; added 
troubleshooting chapters
Fixed numerous small "bugs"

Detail (since release 3.2.4)
numerous screens - continued work on standardized look-and-feel, added Print-Screen 

options to remaining windows, and Print-List/Report options where applicable
LUCIS Installer - alert operator to close LUCIS Software if it is detected to be open; added 

error message, then abort, if user is not administrator; automatically provide 
elevated status to administrator when required to eliminate Windows Vista error 
messages; allow license key to be entered as part of installation; option to install a 
desktop shortcut; option to specify station number for Network Client; option to 
display release notice when installation is done

LUCIS.exe (LUCIS Software Manager) - automatically provide elevated status to 
administrator when required for Windows Vista

Address Module:
AD Windows - added a Print Screen menu option; also Print List/Report where applicable
ADLookup (AD Address Query) - removed address line(s) at bottom of display table when 

no file is open; modified “Add” and “Edit” for users with lower-level access 
permission.

ADAEdit (AD Address Editor) - allow an address to be deleted if “Used By” indicators are 
removed on screen (no longer requires Save first)

ADImport (AD Address Import) - changed default import format to “SP Special Fixed-field 
Format” (the format used to export addresses from CA, SA, and Classic LUCIS

General Ledger Module:
GLPayments (GL Payments Entry) - added prompt to print account statement when posting 

to Loan Payable accounts in Revolving Fund ledgers; added prompt to confirm 
posting when “Post” is selected from the menu

GLReceipts (GL Receipts Entry) - added prompt to print account statement when posting to 
Loan Payable account in Revolving Fund ledgers; added prompt to confirm 
posting when “Post” is selected from the menu

GLTransfer (GL TransferEntry) - fixed Copy Template and Rename Template features; 
added prompt to confirm posting when “Post” is selected from the menu

GLTEntry (GL General Entry) - added prompt to confirm posting when “Post” is selected 
from the menu; use standard account name presentation on voucher

GLTBatch (GL Batch Entry) - added prompt to confirm posting when “Post” is selected from 
the menu; use standard account name presentation on voucher

GLAStmt (GL Account Statements) - added a balance column to Amount Columns options; 
added special options that are appear only for revolving fund ledgers



GLAging (GL Account Aging) - disable window when no file is open
GLTInterest (GL Interest Processing) - disable window when no file is open
GLAEdit (GL Account Editor) - fixed “Save” requiring two clicks when Note tab is 

displayed
GLVerify (GL Verify Ledger Data) - now checks and reports transfer and release errors for 

account balance, report amounts, and budget amounts separately; removed blank 
error message box that appeared when canceling a file open

GLCreate (GL Create New Ledger Fileset) - default to LUCIS\DATA\ folder for new ledger

Donations Module:
DN Windows - added a Print Screen menu option; also Print List/Report where applicable
DNDLookup (DN Donor Query) - removed “Edit” for users with lower-level access 

permission.
DNOLookup (DN Offering Query) - removed “Edit” for users with lower-level access 

permission.
DNTClose (DN Close Open Batch) - added batch total to window display; hid extraneous on-

screen data when no file is open
DNT2GL (DN Post Closed Batch to GL) - removed extraneous on-screen data when no file is 

open
DNOList (DN Offering Lists) - added offering count to total line of lists
DNDList (DN Donor Lists) - added donor count to total line of lists; added recap page to 

Pledges report
DNTList (DN Entry Lists) - minor report fixes and adjustments; added total and grand-total 

donor/offering/batch counts to lists as appropriate; fixed inability to exit Thru-
Month textbox when validation error occurs

DNORemit (DN Remittance Report) - added church name to pages following first page; 
shorten return address display lines to match area available on printout; removed 
local offerings from offering detail on following pages

DNDStmt (DN Donor Statements) - fixed donor name/address not printing when “no goods 
or services” was unchecked; shorten address entry area lines to match area 
available on printout

DNBackup (DN Backup Donation Files) - removed extraneous display used for testing; 
removed blank error message box that appeared when canceling a file open; 
removed extraneous on-screen data when no file is open

DNClose (DN Monthly/Annual Close) - allow updating of donor multi-year pledge amounts 
to reflect prior-year adjusting entries even if the donor ID has been changed; 
fixed “Illegal function call” message when performing a file open; removed 
extraneous on-screen data and error message for users with lower-level access 
permission 

DNDEdit (DN Donor Editor) - changed location for new ID during donor ID change
DNOEdit (DN Offering Editor) - hid extraneous on-screen data during offering ID change; 

fixed inappropriately appearing error messages; allow user to manually supply a 
post-to GL account name, in addition to the post-to account number, if not using 
LUCIS ledger; donor ID now displays when called from “Edit” in DN Donor 
Query; modified to restrict editing of data based on with user access permission

DNVerify (DN Verify Donations Data) - removed blank error message box that appeared 
when canceling a file open; additional verification for entry sets (i.e. envelopes) 
and batches; update offering destination Entity-ID code from current mapping 
data for selected offering destination organization.

DNCEdit - removed pathname for associated GL if DN and GL databases are in the same 



folder
DNCreate (DN Create New Donation Fileset) - default to LUCIS\DATA\ folder for new file



Release 6 Notice - 1/17/2008

Highlights (since release 3.2.5)
Added ability to import donor names/addresses from third-party software
Added ability to import comma-delimited budget amounts
Added features to automate and guide use of software (particularly at month- and year-
end)
Added/Edited numerous error/warning messages; reduced occurrences when warnings 
appear

Detail (since release 3.2.5)
All: eliminated flicker when selecting from file menus; updated “Remove Filename” feature; 

fixed minor inconsistencies
LUCIS.exe (LUCIS Software Manager) - moved a number of advanced functions to sub-

menus to simplify presentation; activated ADCList (AD Controls List); added 
export options to Standard Plus menus

LUCIS.ent (Adventist Entity Query database) - updated with latest GC Archives & Statistics 
data

Address Module:
ADImport (AD Address Import) - allow import into address file containing default address 

automatically placed there with AD Create New Address Book (previously 
required totally empty address book)

ADCList (AD Controls List) - new feature to print an Address Controls List
ADCEdit ( AD Controls Editor) - add “Create Controls List” to Print menu

Donations Module:
DNDQuery (DN Donor Query) - fixed loss of highlight after line is selected when query was 

activated from LUCIS Manager
DNOQuery (DN Offeringr Query) - fixed loss of highlight after line is selected when query 

was activated from LUCIS Manager
DNTEntry (DN Open Batch Entry/Edit) - prompt to open prior year if date used is for prior 

year; automatically close last month if requested when entering donations for new 
month

DNDEdit (DN Donor Editor) - automatically update donor current year pledge receipts when 
pledge date or offering is changed

DNOEdit (DN Offering Editor) - error if GL Posting Account for offering is a transfer 
account; warn if GL Posting Account for offering is an expense account

DNCList (DN Controls List) - allow DN Control List to be printed from other LUCIS 
processes

DNCEdit (DN Controls Editor) - add “Create Controls List” to Print menu; added remittance 
report extension option (for list of offering destination/purpose)

DNImport (DN Donation Fileset Import) - added ability to import Names/Addresses Only
DNTClose (DN Close Open Batch) - update donor current year pledge receipts strictly based 

on donation date compared to pledge date
DNClose (DN Monthly/Annual Close) - window is automatically closed upon completion; 

automatically reclose month 12 on annual close if necessary; allow automatic 
close from other LUCIS processes; fixed month 1 close when month to close is 
not edited



DNTLists (DN Entry Lists/Reports) - added option to hide donor name/ID on report; 
included secondary selection criteria on report headings

DNORemit (DN Remittance Report) - made offering destination/purpose report extension 
optional based on DN Control setting

DNDStmt (DN Donor Statements) - include last line of 4-line address on Summary Receipt
DNVerify (DN Verify Donation Data) - repair donor current year receipts based on pledge 

start date

General Ledger Module:
GLAQuery (GL Account Query) - fixed loss of highlight after line is selected when query 

was activated from LUCIS Manager
GLAEdit (GL Account Editor) - added ability to import comma-delimited budget amounts; 

disable edit of address for user access level 1-3
GLCEdit (GL Controls Editor) - provided drop-down list for ledger code; fixed minor screen 

navigation bugs; fixed inability to exit some error messages if last item edited was 
Last/Next Year ledger names

GLClose (GL Monthly/Annual Close) - allow monthly/annual close to be preformed 
automatically from other LUCIS processes; fixed default name for new ledger on 
annual close

GLPayments (GL Payments Entry) - warn if annual close has been performed on opened file; 
prompt to automatically reclose month 12 if month 12 was previously closed; 
warn if amount entered for expense account will cause account to exceed budget; 
error if entry date is outside of ledger year (Lite/Std/Std+)

GLReceipts (GL Receipts Entry) - warn if annual close has been performed on opened file; 
prompt to automatically reclose month 12 if month 12 was previously closed

GLTEntry (GL General Entry) - warn if annual close has been performed on opened file; 
fixed incorrect identification of some journal types on printed vouchers; prompt 
to automatically reclose month 12 if month 12 was previously closed; warn if 
amount entered for expense account will cause account to exceed budget

GLTBatch (GL Batch Entry) - warn if annual close has been performed on opened file; 
prompt to automatically reclose month 12 if month 12 was previously closed; 
warn if amount entered for expense account will cause account to exceed budget

GLTransfer (GL Transfers Entry) - warn if annual close has been performed on opened file, 
prompt to automatically reclose month 12 if month 12 was previously closed; 
warn if amount entered will cause account to exceed budget

GLTImport (GL Import Entries) - warn if annual close has been performed on opened file; 
prompt to automatically reclose month 12 if month 12 was previously closed

GL1099I (GL 1099-INT Report) - allow 3-line addresses (plus name); adjust alignment of 
federal ID on 1099

GLFReports (GL Financial Reports) - activated function lookups for Function Detail Report 
range selection; eliminate “Multi-Fund” option except for Professional ledgers

GLFReport2 (GL Financial Reports (Adv) - activated function lookups for Function Detail 
Report range selection; remove ledger description when filename is cleared



Release 7 Notice - 6/12/2008

Highlights (since release 3.2.6)
implemented new “Startup Wizard” for setting up new sites (see Getting Started chapter)--
no longer requires downloading starter files from our website
implemented new “Auto-Assist” option to simplify menus, program use, and automate 
processes (see Tools menu of LUCIS Software Manager) - run “Auto-Assist File Prep” in 
Advanced Options of Tools menu to prepare files for “Auto-Assist” use
added new Quick Start Toolbar option to LUCIS Software Manager (see Tools menu)
added new “Add Offering Wizard” to guide in setting up new offerings
added “Check for updates…” feature in Help menu--it will determine if an update is 
applicable and guide download and installation (requires internet connection)
added seasonal budget feature for ledger levels III/IV with Adv/Pro Software Editions
added entry batch manager for use with ledger level III (Std)
added user access level 3 (read-only) to GL Account Reconciliation feature (for audit 
use)
moved donations import from standalone feature to option in donations entry window
updated on-line helps for new features

Detail (since release 3.2.6)
All Programs: updated for current internal standards; edited messages; implemented “Auto-

Assist” feature to simplify menus, program use and automate functions; 
additional prompts to guide program users; increased communication between 
program features; added organization name to windows title bar when “Auto-
Assist” is on

LUCIS.exe (LUCIS Software Manager) -  removed custom report editors from File menu 
(they are available in Advanced Tools in the Tools menu); reorganized Tools 
menu; added “Auto-Assist” option in Tools menu; simplified menus options for 
“Auto-Assist”; prevent multiple simultaneous selection of features in “Auto-
Assist” mode; allow selection of working folder in “Auto-Assist” mode 
(organization name of selected data folder is shown on title bar); menu item for 
any application module without data is deactivated in “Auto-Assist” mode; 
automatically starts in LUCIS Startup Wizard if software is being run the first time

AutoPrep (Auto-Assist File Prep): New Advanced Tools menu option of LUCIS Software 
Manager to prepare files for use with “Auto-Assist” option (convert to 
standardized data folder and file names)

LUCIS.ent (Adventist Entity Query database): updated with latest GC Archives & Statistics 
data

LUCIS-STD.rpt - changed column 3 heading from “Actual” to “Budget” on Inc/Exp 
Month/YTD Actual/Budget Activity (report controls FA 2-4 MAB+ and FA 2-4 
MAB+T); added current budget only report for ledger level VI (Adv) and VIII 
(Pro) standard (style=FD95 2-8 DTL; report control=FD95 6-8 DTL)

Address Module:
ADLookup (AD Address Query) - disabled select button when called from LUCIS 

Manager
ADVerify (AD Verify Address Book) - automatic data backup prior to repair run

Donations Module:
DNDEdit (DN Donor Editor) - hide pledge and history data if user access level < 6



DNOEdit (DN Offering Editor) - activate Alt-X keyboard shortcut to exit; new Offering 
Wizard feature for adding new offerings

DNOLookup (DN Offering Query) - added non-deductible status indicator
DNTEntry (DN Open Batch Entry/Edit) - warn if open batch date is different from entry 

date; automatic annual close of old year (if not already done) when entering data 
for new year; error if entry date is not for donation year (must select correct 
donation year); implemented donations import as option (removed as standalone 
feature)

DNTClose (DN Close Open Batch) - automate month 12 and annual close as needed; prevent 
new donation batch close until prior LUCIS GL month has been closed when 
“Auto-Assist” is on; automatically post any unposted batches before closing open 
batch when “Auto-Assist” is on

DN2GL (DN Post Closed Batch to GL) - coordinate with DNTClose (DN Close Open Batch) 
to automate batch close / post to GL process; automatically update GL link when 
posting a batch to the next GL fiscal year (DN is always calendar year; GL may 
be non-calendar fiscal year; this feature synchronizes the two); changed voucher 
from table format to tab format; fixed Db/Cr designation for non-decimal 
currency

DNClose (DN Monthly/Annual Close) - automatic backup of data folder when “Auto-Assist”
is on; automatically update applicable “new year” balances when reclosing month 
12 of “old year” to record effect of prior-year entries/adjustments when “Auto-
Assist” is on; coordinate with DNTClose (DN Close Open Batch) to automatically 
perform month/annual close if needed

DNDList (DN Donor Lists) - remove pledge and history data selection if user access level < 
6; adjusted amount column for non-decimal currency

DNOList (DN Offering Lists) - adjusted offering number column to prevent misalignment; 
adjusted amount column for alignment of non-decimal currency

DNTLists (DN Entry Lists/Reports) - adjusted offering number column to prevent 
misalignment; adjusted amount column for alignment of non-decimal currency; 
made donor and offering identification columns (number and name) wider to 
prevent misalignment

DNTDeposit (DN Deposit List) - adjusted amount column for alignment of non-decimal 
currency

DNORemit (DN Remittance Report) - adjusted amount column for alignment of non-decimal 
currency; identified non-tax-deductible offerings on report

DNImport (DN Donation Fileset Import) - changed output default to standard 
folder/filenames

DNCreate (DN Create New Donation Fileset) - changed default to standard folder/filenames
DNVerify (DN Verify Donation Data) - automatic data backup prior to repair run

General Ledger Module:
GLOrganizer (GL Account Organizer) - automatically create an income and expense account 

in new functions for level III and IV ledgers (Std/Std+); fixed disappearing 
balance account on failed delete attempt

GLAEdit (GL Account Editor) - enabled seasonal budget for ledger level IV with Adv/Pro 
Software License; changed Global Budget Utility (in Utilities menu) to show all 
skipped records when importing budget amounts; added raw/-=Cr/-=Db options 
to indicate interpretation of sign in budget amounts being imported

GLPayments (GL Payments Entry) - fixed problem refocusing on check amount when focus 
was on amount in distribution table; added menu option to turn on/off over-



budget warning when posting to expense accounts; automatically reclose final 
month after posting addition final month entries; added [Batch] button for entry 
batch manager

GLReceipts (GL Receipts Entry) - fixed problem refocusing on receipt amount when focus 
was on amount in distribution table; automatically reclose final month after 
posting additional entries; added [Batch] button for entry batch manager

GLTEntry (GL General Entry) - automatically reclose final month after posting additional 
entries; adjusted voucher for alignment of non-decimal currency; added [Batch] 
button for entry batch manager

GLTBatch (GL Batch Entry) - automatically reclose final month after posting additional 
entries; adjusted voucher for alignment of non-decimal currency; added [Batch] 
button for entry batch manager

GLTImport (GL Import Entries) - automatically reclose final month after importing 
additional entries

GLTransfer (GL Transfer Entries) - automatically reclose final month after importing 
additional entries; made right margin on report wider to accommodate some 
printers; adjusted voucher for alignment of non-decimal currency

GLTReconcile (GL Account Reconciliation) - added user access level 3 (read-only); adjusted 
report for alignment of non-decimal currency; fixed calculated balance on report 
for non-decimal currency; increased amount size to allow for larger amounts

GLTList (GL Entry List-Journal) - changed from table format to tab format
GLClose (GL Monthly/Annual Close) - added automatic backup of data folder before close; 

automatic backup of data folder when “Auto-Assist” is on; automatically update 
“new year” balances when reclosing month 12 of “old year” to record effect of 
prior-year entries/adjustments when “Auto-Assist” is on; eliminated decimal from 
net balance “posted” line of closing report for non-decimal currency

GLABalance (GL Account Balance List) - adjust amount column for non-decimal currency
GLAStmt (GL Account Statements) - fixed sign of balance if no entries to print; adjusted 

amount column for non-decimal currency
GLFileIn (GL Ledger Fileset Import) - changed output default to standard folder/filenames
GLCreate (GL Create New Ledger Fileset) - changed default to standard folder/filenames
GLVerify (GL Verify Ledger Data) - automatic data backup prior to repair run

Release 8 Notice - 11/11/2008

Highlights (since release 3.2.7)
NEW GL ENTRY IMPORT for Bookstore Manager (point-of-sale/inventory 
management)
NEW GL ENTRY IMPORT for FACTS (tuition management/collection service)
NEW GL MENU FEATURE to move selected account balances from one account area to 

another (primarily designed to move student A/R balances from current to old)
NEW GL MENU FEATURE to allow editing of Next Year or Current Year budget for all 

accounts in a function (local fund) at the same time
NEW standard GL Financial Statement Reports for Next Year Budget (Std/Std+)
NEW Signature option included for Interest Payment Checks (Pro)
INCLUDED TEXTMAKER VIEWER (freeware) as optional LUCIS viewer (this will 



eventually replace Microsoft Word Viewer as the default LUCIS viewer)
CHANGED FILE BROWSE to start in specified folder rather than last Windows folder
CHANGED FONT (darker, italic) of running totals on entry windows so they show up 

better

Detail (since release 3.2.7)
All: changed file browse windows to start in specified folders rather than last Windows folder; 

included TextMaker Viewer (freeware) as optional LUCIS viewer
LUCIS.exe (LUCIS Software Manager) -added GL menu selections for GL Move Account 

Balances and GL Account Budget Editor; added Image Converter (Pro Edition) 
to convert jpg images to secure encrypted format (signatures, etc.)

LUCIS.ent (Adventist Entity Query database): updated with latest GC Archives & Statistics data
LUCIS-STD.rpt - added “Next Year” budget reports for GL Financial Reports (Std/Std+)
LUCIS Helps: updated for changes

Address Module:
ADLookup (AD Address Query) - expand window subtitle for longer address book name
ADCEdit (AD Address Controls Editor) - limit address book name to maximum saved length

Donations Module:
DNTLookup (DN Donation Query) - check DNXRef Index and rebuild if necessary
DNDEdit (DN Donor Editor) - moved “Donor Giving Unit” to “Donor Notes” section; warn 

if new pledge date is not in calendar year; fixed next/previous donor shortcut (Alt-
Up/Dn at donor ID)

DNOEdit (DN Offering Editor) - fixed data base indexing when changing offering name; 
fixed error encountered when switching back and forth multiple times between 
YTD and Month options on Report Balances tab; fixed Offering Wizard to handle 
“Other” ledger types and when “LUCIS ledger” specified is not available

DNTEntry (DN Open Batch Entry/Edit) - automatically activate offering query after OK 
response to “offering does not exist” error message; changed font (darker italics) 
of running total

DNTClose (DN Close Open Batch) - when Auto-Assist is ON automatically tries to find 
appropriate LUCIS ledger for posting batch if no ledger had previously been 
identified

DNTLists (DN Entry Lists/Reports) - fixed misinterpretation of “Months” selection period 
(From/Thru less than 12 were mistakenly interpreted as “Batches”); fixed 
problem where some “subtotal by donor” reports only included last donor 
selected; fixed misreporting when month prior to selected starting month was not 
closed (report started from beginning in these cases rather than the last month 
cutoff prior to the start selection); new error if unclosed month is used for month 
range selection; require month/batch selection; fixed problem when operator 
clicked “Create Report” immediately after editing donor or offering range 
selection (the data in the edited field was nor recognized); reject batch(s) selection 
for “Quarterly Comparison” column report selection; reset range when switching 
between batch and month selection; fixed display of default values when 
reselecting “Standard Format” after running a list using custom formatting; 
disable “Show Detail” in formatting selection for all but “Standard” column 
selection; fixed error when 2-year comparison report is selected; set “skip zero 
amount lines” as default for all custom column reports; check DNXRef Index and 
rebuild if needed



DNClose (DN Monthly/Annual Close) - Monthly: warn if intervening months are not closed; 
update data to reflect confirmed (intentional) skipped month(s)
Annual: added prompt for permanent archive backup; print outstanding pledge 
report for new year; update for unclosed (skipped) months

DNVerify (DN Verify Donation Data) - added additional verification checks; eliminated 
“Illegal Function Call” starting verify when opening file does not exist; additional 
closed month checks; verify DNXRef Index and rebuild if needed

General Ledger Module:
GLPayments (GL Payments Entry) - automatically activate account query after OK response 

to “account does not exist” error message; eliminated redundant “ledger already 
closed” warnings; changed font (darker italics) of running total

GLReceipts (GL Receipts Entry) - automatically activate account query after OK response to 
“account does not exist” error message; eliminated redundant “ledger” already 
closed” warnings; changed font (darker italics) of running total

GLTEntry (GL General Entry) - automatically activate account query after OK response to 
“account does not exist” error message; changed font (darker italics) of running 
total; removed redundant date warnings

GLTBatch (GL Batch Entry) - automatically activate account query after OK response to 
“account does not exist” error message; changed font (darker italics) of running 
total

GLTransfer (GL Transfers Entry) - automatically activate account query after OK response to 
“function does not exist” error message; changed font (darker italics) of running 
total

GLTImport (GL Import Entries) - import Bookstore Manager (point-of-sale and inventory 
management) detail or summary data; import FACTS (tuition management and 
collection) payment detail CSV

GLTList (GL Entry List: Journal) - adjust acct# column width to prevent line wrapping
GLFReports (GL Financial Reports) - added new reports for “Next Year” budget
GLAStmt (GL Account Statements) - fixed disappearing buttons when running “full screen”
GLTReconcile (GL Account Reconciliation) - automatically activate account query after OK 

response to “account does not exist” error message; added links in Edit menu to 
call GL Entry programs to allow posting of missing entries with AutoAssist=ON

GLAging (GL Account Aging) - force aging report and update of aging history when last 
account being aged is also end-of-file; added automatic folder backup option 
before aging

GLTInterest (GL Interest Processing) - added automatic folder backup option before 
processing; added signature image option for interest checks; automatic purge of 
check documents when closing window

GLMoveBal (GL Move Account Balances) - NEW GL MENU FEATURE to move account 
balances from one classification to another (primarily designed for moving 
student 

GLClose (GL Monthly/Annual Close) - Annual: fixed new fiscal year when closing short 
year (short year is primarily used to transition between calendar and fiscal year 
and visa versa); fixed standard filename of new fiscal year when closing short 
year; added prompt for permanent archive backup; updated for unclosed 
(skipped) months; eliminated redundant “Aging has not been run…” messages

GLOrganizer (GL Account Organizer) - removed prompt to update all accounts when 
disabling interest; eliminated occasional printing of superfluous data with “Print 
Screen”.



GLAEdit (GL Account Editor) - when changing budget for a transfer or release account the 
software now automatically updates the corresponding account budget; fixed 
response to “missing address link” warning message for linked A/R addresses; 
note Db/Cr orientation of budget amount in budget entry area

GLABudget (GL Account Budget Editor) - NEW GL MENU FEATURE to allow editing of 
New or Current budget for all accounts in a function (local fund) at the same time

GLVerify (Verify Ledger Data) - additional closed month checks



Release 9 Notice - 2/17/2009

Highlights (since release 3.2.8)
Added annual reoccurring offering goal type
Added Adventist Giving (on-line giving) entry options
Added “BD - Bank Deposit” journal type and number tracking for all ledgers
Expanded options for Adv/Pro software editions even when using lower level ledgers

Detail (since release 3.2.8)
LUCIS.exe (LUCIS Software Manager) - fixed inappropriate Auto-Assist warning of missing 

donation files when donation module is not installed
LUCIS Loan Amortization Calculator (under Tools) - revised window layout and operator 

interface; updated for keyboard navigation
LUCIS Auto Prep - added warnings if data folders are inappropriately named based on response 

to multiple-entity query
LUCIS Image Converter (for interest check signature) - allow space in filename; fixed 

misinterpretation of image size when signature image has been modified by Adobe 
Photoshop; use LUCIS base folder as base folder for image file browse

LUCIS Image Viewer - added ability to view LUCIS converted images (.lim)
LUCIS.ent (Adventist Entity Query database): updated with latest GC Archives & Statistics data
LUCIS Helps: updated for changes

Donations Module:
DNDEdit (DN Donor Editor) - added note to indicate if pledge is for current year or multi-

year based on offering goal type
DNOEdit (DN Offering Editor) - remove “Add” button from Print Screen when not in use; 

changed “multi-year” checkbox to drop-down goal type selection for multi-year, 
single-year, or annual reoccurring; recalculate goal amount as needed when goal 
type is changed; changed window layout on tab 1 (General Info - especially goal 
section)

DNTEntry (DN Open Batch Entry/Edit) - force update of receipt total when focus changes 
from receipt table entry amount to a point outside the table; force update of 
offering total when focus changed from offering distribution entry amount to a 
point outside the table; restore all window display attributes after “Print Screen”; 
added “Adventist Giving” in receipt table; added temporary “Adventist Giving”
preference setting to optimize entry of Adventist Giving receipts (re: DNCEdit)

DNTClose (DN Close Open Batch) - added validation of open batch before allowing close
DNOLists (DN Offering Lists) - note single-, multi-year, or annual reoccurring goals
DNDLists (DN Donor Lists) - note current year vs multi-year pledges
DNTDeposit (DN Deposits List) - added AdvGiving column to report
DNClose (DN Monthly/Annual Close) - single-year pledges not forwarded to new year; 

annual reoccurring pledge data are carried forward to new year resetting amounts 
to zero; multi-year pledges are carried forward to new year with prior-year 
amount noted; added prompt to annual close to confirm that Adventist Giving 
data has been entered if Adventist Giving control is set (re: DNCEdit)

DNVerify (DN Verify Donation Data) - verify current year vs multi-year pledges
DNCEdit (DN Donations Controls Editor) - added Adventist Giving control for organizations 

participating in on-line giving



General Ledger Module:
GLPayments (GL Payments Entry) - force update of distribution total when focus changes 

from a table entry amount to a point outside the table; restore all window display 
attributes after “Print Screen”; set journal type options based on software edition; 
increased number of table entries, allow use of transfer accounts, and allow out-
of-range dates for Adv/Pro software editions

GLReceipts (GL Receipts Entry) - force update of distribution total when focus changes from 
a table entry amount to a point outside the table; restore all window display 
attributes after “Print Screen”; set journal type options based on software edition; 
increased number of table entries, allow use of transfer accounts, and allow out-
of-range dates for Adv/Pro software editions 

GLTEntry (GL General Entry) - delay voucher number alert message until window has 
opened; force update of screen total when focus changes from a table entry 
amount to a point outside the table; restore all window display attributes after 
“Print Screen”; added “BD - Bank Deposits” journal type for all ledgers; set 
additional journal type options based on software edition; increased number of 
table entries and allow out-of-range dates for Adv/Pro software editions; changed 
position of table total and buttons at bottom of window

GLTBatch (GL Batch Entry) - force update of screen total when focus changes from a table 
entry amount to a point outside the table; restore all window display attributes 
after “Print Screen”; added “BD - Bank Deposits” journal type for all ledgers; 
increased number of table entries and allow out-of-range dates for Adv/Pro 
software editions

GLTransfer (GL Transfers Entry) - force update of distribution total when focus changes 
from a table entry amount to a point outside the table; restore all window display 
attributes after “Print Screen”

GLTImport (GL Import Entries) - set journal type options based on software edition, updated 
Bookstore Manager Import to handle multiple stores

GLTEdit (GL Entries Editor) - set journal type options based on software edition; allow out-
of-range dates for Adv/Pro software editions

GLTInterest (GL Interest Processing) - fixed several “glitches” with use of signature image 
option; added progress status when producing interest checks; changed interest 
check transaction date to be same as check date

GLClose (GL Monthly/Annual Close) - changed default next year filename default when 
Auto Assist is off; fixed copying next year budget from “old” ledger to current 
budget of “new” ledger; changed “DN” text to “GL” in month 12 closed message

GLAEdit (GL Account Editor) - allow tracking of electronic payments based on software 
edition

GLABudget (GL Account Budget Editor) - added “Utilities” menu option for Global Budget 
Utility (copies budget amounts from other ledgers or between new and current 
budget;); fixed error when last record of current year and prior year do not 
match

GLVerify (GL Verify Ledger Data) - added journal type checks based on software edition
GLCEdit (GL Controls Editor) - added electronic payments number tracking based on 

software edition


